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Chapter1Chapter1Chapter1Chapter1 IntroductionIntroductionIntroductionIntroduction

1.11.11.11.1 EzCad2EzCad2EzCad2EzCad2 BriefBriefBriefBrief IntroductionIntroductionIntroductionIntroduction

1.1.11.1.11.1.11.1.1 SoftwareSoftwareSoftwareSoftware InstallationInstallationInstallationInstallation
The EzCad2 software run on an PC with 900 MHz CPU and 256 MB RAM at least. In

general, we recommend the fastest PC available. EzCad2 was developed in Microsoft Windows
XP and will run in Windows XP and VISTA

The installation of EzCad2 is very easy. Users simply need to copy EzCad2 folder that is in
the Install CD to hard disk, and then double click the Ezcad2.exe under the EzCad2’s directory to
run the software.

EzCad2 requires a software security device sometimes known as a 'dongle'. This device
plugs into the USB port on the PC. If there is no dongle or the dongle do not install correctly, a
caution will appears and the software will work at demo state. In demo state, we can evaluate the
software but we cannot save files and cannot control laser device.
1.1.21.1.21.1.21.1.2 SoftwareSoftwareSoftwareSoftware FunctionFunctionFunctionFunction
Main functions of the software:
� Users can design their graphics freely.
� Various types of fonts are supported. Such as TrueType, SHX, JSF(Single line font defined

by EzCad2), DMF(Dot Matrix Font), One-Dimensional bar code, Two-Dimensional bar
code , and so on)

� Flexible variable text: changes the text real time while in laser processing. Excel datasheet is
supported.

� Can through the serial port direct read text data
� Can through the network direct read text data
� Strong node editing function make the curve modification more easier
� The software can support 265 “pencils”, which used to draw graphic and can be set different

processing parameters.
� Common types of images are supported. (bmp, jpg, gif, tga, png, tif…)
� Common vector images are supported. (ai, dxf, dst, plt…)
� Image processing (Grayscale, White / Black Transformations)
� Powerful hatching functions, such as support round hatch.
� More convenient IO operations and more easier to harmonize the auxiliary equipments.
� Supports the dynamic focus (3 axis processing system)
� Supports directly the SPI G3 fiber laser and the newest IPG_YLP and IPG_YLPM fiber laser
� An opening language supporting system makes it easy to run the software in various

languages platform.
1.1.31.1.31.1.31.1.3 InterfaceInterfaceInterfaceInterface IntroductionIntroductionIntroductionIntroduction

���� SoftwareSoftwareSoftwareSoftware startingstartingstartingstarting interfaceinterfaceinterfaceinterface
The picture (Figure 1-1) appears while running the program, and meanwhile the initial

operations takes place in the background.
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Figure 1-1 Program starting interface

���� MainMainMainMain InterfaceInterfaceInterfaceInterface (Figure(Figure(Figure(Figure 1-2)1-2)1-2)1-2)

Figure 1-2 EzCad2 Main Window

1.21.21.21.2AboutAboutAboutAbout EzCad2EzCad2EzCad2EzCad2 UserUserUserUser’’’’ssss ManualManualManualManual

1.2.11.2.11.2.11.2.1 ContentsContentsContentsContents ArrangementArrangementArrangementArrangement

The User’s Manual will introduce each menu (File, Edit, Draw, Modify, View, Help) in turn.

1.2.21.2.21.2.21.2.2 AnnouncementAnnouncementAnnouncementAnnouncement



EzCad2UNI User’s Manual

7 All rights reserved

ChapterChapterChapterChapter 2222 FileFileFileFile MenuMenuMenuMenu

The File Menu is used for open and save files (Figure 2-1)

Figure 2-1 File Menu

2.2.2.2.1111 OpenOpenOpenOpen (O)(O)(O)(O)

“Open” is used to load a saved “.ezd” file, the software will pop an open-file dialog to ask
you select the file you want to open, See fig 2-2. .

Figure 2-2 “Open” Dialog Box

The files saved with other file-format will not be opened by the “Open” command.

2.2.2.2.2222 SaveSaveSaveSave (S)(S)(S)(S)

“Save” file is used to save the current state of a mark Document to disk. Writing a file to its
current name is the same as the Save function.
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Figure 2-3 “Save” dialog box

If the current Document has already been named, “Save” is selected to save it under the name
that was used to open the file, or the software will prompt to the user to choose a destination path
and type a name.

2.2.2.2.3333 ObjecObjecObjecObjectttt ListListListList

Object List is in the left side of the main interface window.
Marked objects are grouped into an object structure or ungrouped to many objects. (Figure

2-12)
When in marking process, system will follow the order to mark the objects listed.
Users can rearrange the list by directly dragging the object up/down or right keyboard to

change the marking order.
Users can double click the object bar to name them.
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Figure 2-12 Object List

2.2.2.2.4444 ObjectObjectObjectObject PropertiesPropertiesPropertiesProperties

ObjectObjectObjectObject PropertiesPropertiesPropertiesProperties are displayed in the left side of the main interface window

� XXXX position:position:position:position: the X coordinate of the
point in the left button corner of the
object selected.

� YYYY position:position:position:position: the Y coordinate of the
point in the left button corner of the
object selected

� ZZZZ position:position:position:position: the Z coordinate of
selected object

� XXXX SizeSizeSizeSize:::: width of the object selected
� YYYYSizeSizeSizeSize:::: height of the object selected

� : Lock the current width/height proportion of the object selected. If user changes the

object’s size, system will keep the X/Y ratio. Click the button will switch to unlock state

: The coordinate data ((((XXXX positionpositionpositionposition,,,, YYYY positionpositionpositionposition)))) is maped to which point of the object.

Figure 2-13 Object Property
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ChapterChapterChapterChapter 3333 EditEditEditEdit MenuMenuMenuMenu

3.3.3.3.1111 CutCutCutCut (T)(T)(T)(T) //// CopyCopyCopyCopy (C)(C)(C)(C) //// PastePastePastePaste (P)(P)(P)(P)

“Cut” will delete the object selected from EzCad2 and copy it to the clipboard. It can be
inserted back into the .ezd file later using “Paste” function. Note that it will be lost if other data is
copied to the clipboard.

“Copy” will copy the selected object to the clipboard and reserve the current object.

“Paste” will paste the object from the clipboard to current document file.

is copy,paste,cut button.

3.3.3.3.2222 CombineCombineCombineCombine //// UncombineUncombineUncombineUncombine

“Combine” will ignore all the selected objects’ curve properties and combine those objects
into a new curve combination with new curve properties. Same as other objects, this new
combination can be selected, copied, pasted and set properties.

“Uncombine” will get the combination back to the curve objects separately. The objects after
“Uncombine” may be different from those before “Combine”. “Undo” should be used to restore
the original objects

The feature Combine’s icon in Toolbar is , and the feature Uncombine’s icon in Toolbar

is .

The shortcut keys of “Combine” and “Uncombine” respectively are: Ctrl+L and Ctrl+K.

3.3.3.3.3333 GroupGroupGroupGroup //// UnGroupUnGroupUnGroupUnGroup

When selected the “Group” function will keep the selected objects’ original properties and
make them into a new object, and this new group, as the same as other object, can be selected,
copied, pasted and set object properties.

“Ungroup” will turn the object which has just been grouped into previous situation. The
object which has just been grouped by more than 1000 objects will become 10 objects. If the
object is a vector file which has different pen color, it will become some objects according to
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color.

The icon of Group in Toolbar is , and UnGroup’s is .

The shortcut keys of “Group” and “UnGroup” respectively are: Ctrl+G and Ctrl+U.

3.3.3.3.4444 HatchHatchHatchHatch

“Hatch” is used to force EzCad to calculate the hatch fills for the current objects. The object
to be filled must be closed curve, and if you choose many objects to fill, these figures can be
objects nested mutually. Any two objects may not have intersectant parts (Figure 3-2)

Figure 3-2 Hatch

(Objects on the left can be filled; The two rectangles on the right may get unexpected result for they

intersect each other.)

The icon of Hatch in Toolbar is , and when selected a hatch dialog box will appear as Figure

3-3 shows.
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MarkMarkMarkMark Contour:Contour:Contour:Contour: whether to show and mark the current object’s contour or not

means when click ‘Mark Contour’, mark hatch line first then mark contour

means when click ‘Mark Contour’,

mark contour first then mark hatch line
HatchHatchHatchHatch 1111 //// HatchHatchHatchHatch 2222 //// HatchHatchHatchHatch 3333:::: Users may have

three independent hatch parameters to hatch the
same object at the same time. Each set of hatch
parameters can be appointed a Pen No. which
stands for a set of marking parameters.

EnableEnableEnableEnable:::: whether to permit the validity of the
current hatch parameter.

AllAllAllAll Calc:Calc:Calc:Calc: Calculate all the selected objects as
a whole. This is an optimizing option. In some
cases the speed of marking may highly be raised. It
will take long time to calculate large, complex
objects. When not selected, the objects will be
calculated separately.
For example: draw three rectangles, line distance is
1mm, angle is 0.
1. Do not click ‘All Calc’, system will mark as the order in object list, mark hatch line in the first

rectangle then mark hatch line in the second rectangle, and so on.
2. Click ‘All Calc’, mark all the hatch line at one time, mark all the hatch that on the same line.
3. Marking result as follow fig 3-4:

Fig 3-4(a) do not click ‘All Calc’, the hatch line are not in the same line

Figure 3-3 Hatch
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Fig 3-4(b) click ‘All Calc’, hatch line are in the same line
Type of Hatch: (Figure 3-5)

UnidirectionUnidirectionUnidirectionUnidirection hatchhatchhatchhatch:::: The hatch lines will be marked from left to right.

BidirectionalBidirectionalBidirectionalBidirectional hatchhatchhatchhatch:::: The hatch lines will be marked from left to right first, and then

from right to left.

Ring-likeRing-likeRing-likeRing-like hatchhatchhatchhatch:::: fills objects from the outside to the inside like a ring

Click the button will switch between the Unidirection, bidirectional, and ring-like hatch.

Figure 3-5 Types of hatch

(The left object is being filled by Unidirection Hatch or Bidirectional Hatch, and the right object by

Ring-like hatch)

Angle:Angle:Angle:Angle: Hatch Angle stands for the angles between hatch lines and X axis, and Figure 3-6 is
the feature when the angle is 45 degrees.
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LLLLineineineine SpaceSpaceSpaceSpace:::: the space between two hatch lines
EdgeEdgeEdgeEdge offsetoffsetoffsetoffset:::: the distance between hatch lines and

the object’s outline (Figure 3-7)

Figure 3-7 Border Distance

(The left object shows the figure when Edge offset is 0 and the right shows when it is 0.5.)

FollowFollowFollowFollow edgeedgeedgeedge oneoneoneone timetimetimetime:::: draws outline one time around the hatch lines after filling (Figure
3-8)

StartStartStartStart Offset:Offset:Offset:Offset: the
distance between the first fill line and the border of the object

EndEndEndEnd Offset:Offset:Offset:Offset: the distance between the last fill line and the border of the object
Figure 3-9 shows the feature when it is filled.

Figure 3-6 Degrees

Figure 3-8 Follow edge one

(The left object do not enable this option and the right one do.)
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Figure 3-9 Offset Distances

(The left figure is the object when the Start offset and End Offset are 0,

and the right figure is the object when the Start offset and End Offset are both

0.5.)

AverageAverageAverageAverage distributedistributedistributedistribute line:line:line:line: The solution the starting and ending hatch line are non-average
distributes question when the object is hatched. After select this item, the software automatic
adjust the hatch line space in the user setting hatch line space foundation, will let the hatch line
average distribute.

Linereduction:Linereduction:Linereduction:Linereduction: The hatch line both sides reduction. (Figure 3-10)

NumLoops:NumLoops:NumLoops:NumLoops: The times of Ring-like hatch before the aclinicing hatch (Figure 3-11).

Figure 3-10 Linereduction

( The left figure is the object when the Linereduction is 0,the middle figure is the object

when the Linereduction is 0.5, and the right figure is the object when the Linereduction is -0.5)
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AutoAutoAutoAuto roraterorateroraterorate hatch:hatch:hatch:hatch: Refers to after every marking, the hatch line will fill the revolving angle
which we setted automatically to marking again. For example, angle is 0, aoto rotate angle is 30,
the first mark angle is 0, the second is 30, the third is 60, and so on.

3.3.3.3.5555 ToToToTo originoriginoriginorigin

to origin

3.63.63.63.6 DeletDeletDeletDelet

delet

ChapterChapterChapterChapter 4444 DrawDrawDrawDraw MenuMenuMenuMenu

“Draw Menu” consists of various common items for drawing, for instant, Dot, Line, Curve,
Polygon, etc. Draw Menu has a Toolbar correspondingly, and all the operations can be achieved
by pressing the icon on the Toolbar. For example, as Figure 4-1 shows, when you have selected
the drawing command or the icon in Toolbar, the Present Command Toolbar on the top of the main
window will be changed to show some options of the current command.

Figure 3-11 NumLoops

( The left figure is the object when the NumLoops is 0,and the right figure is the object when the NumLoops is 2)



EzCad2UNI User’s Manual

17 All rights reserved

（a）

Figure 4-1 Draw Menu

（The three pictures above stand for: (a) Draw Toolbar; (b) Draw Menu; (c) Command Toolbar）

4.34.34.34.3 RectangleRectangleRectangleRectangle

To draw a rectangle, users can select command “Rectangle” in Draw Menu or click the

icon .

Under the command “Rectangle”, users can press the left button of the mouse and drag it to
draw a rectangle.
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Under the command “Rectangle”, users can draw a square
by pressing the left button of the mouse and drawing it when
press “Ctrl” key synchronously.

After drawing and selecting, the Properties Toolbar will
display a feature like Figure 4-3 shows.

ArcArcArcArc radiusradiusradiusradius:::: This refers to the smooth degree of the
rectangle’s four corners, and when the degrees are 100%, then
the rectangle changes into a circle.

AllAllAllAll cornercornercornercorner Round:Round:Round:Round: When selected, users can change the
angles of the four corners at the same time just by changing one
of them.

NOTE:NOTE:NOTE:NOTE: AfterAfterAfterAfter changingchangingchangingchanging thethethethe parametersparametersparametersparameters inininin thethethethe PropertiesPropertiesPropertiesProperties
ToolbarToolbarToolbarToolbar eacheacheacheach time,time,time,time, wewewewe mustmustmustmust clickclickclickclick ““““ApplyApplyApplyApply”””” buttonbuttonbuttonbutton totototo updateupdateupdateupdate
thethethethe objectobjectobjectobject withwithwithwith newnewnewnew parameters.parameters.parameters.parameters.

4.44.44.44.4 CircleCircleCircleCircle

To draw a circle, users can select command “Circle” in the Draw Menu or click the

icon .

Under the command “Circle”, users can press the left button and drag it to draw a circle.
After drawing and selecting, the Properties Toolbar will display a feature like Figure 4-4

shows.

Diameter:Diameter:Diameter:Diameter: the diameter of the circle
StartingStartingStartingStartingAngle:Angle:Angle:Angle: the angle between the starting

point and the centre of a circle

: This figure refers to the drawing

direction of the circle is clockwise.

: This figure refers to the drawing
direction of the circle is anticlockwise.

4.54.54.54.5 EllipseEllipseEllipseEllipse

To draw an ellipse, users can select command “Ellipse” in Draw Menu or click the icon.

Figure 4-3 Rectangle Properties

Figure 4-4 Circle Properties
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Under the command “Ellipse”, users can press the left button of the mouse and drag it to
draw an ellipse.

Under the command “Ellipse”, users can draw a circle by pressing the left button of the
mouse and drawing it when press “Ctrl” key synchronously.

After drawing and selecting, the Properties Toolbar will
display a feature like Figure 4-5 shows.

StartStartStartStart Angle:Angle:Angle:Angle: the angle between the starting point and the
centre of an ellipse

EndEndEndEndAngle:Angle:Angle:Angle: the angle between the ending point and the centre
of an ellipse

: This figure refers to the drawing direction of the

ellipse is clockwise.

: This figure refers to the drawing direction of the
ellipse is anticlockwise.

4.64.64.64.6 PolygonPolygonPolygonPolygon

To draw a polygon, users can select command “Polygon” in Draw Menu or click icon .

Under the command “Polygon”, users can press the left
button of the mouse and drag it to draw a polygon.

After drawing and selecting, the Properties Toolbar will
display a feature like Figure 4-6 shows.

EdgeEdgeEdgeEdge Num:Num:Num:Num: This item indicates the number of the
polygon’s borders, and that is at least three. Normally the
border number is less than ten, and with borders more than ten
the polygon will look like a circle.

: When selected, the current polygon to be drawn will
be a convex polygon.

: When selected, the current polygon to be drawn will
be a star.

4.74.74.74.7 TextTextTextText

Figure 4-5 Ellipse Properties

Figure 4-6 Polygon Properties
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Typing text directly in the workspace is supported in EzCad2, and many types of fonts are
supported. To type text, users can select command “Text” in the

Draw Menu or click icon.

Under the command “Text”, users can set up a starting point
at any position wanted in the workspace to type characters by left
click mouse.

4.7.14.7.14.7.14.7.1 CharacterCharacterCharacterCharacter PropertiesPropertiesPropertiesProperties

When selected, the Properties Toolbar will display a feature
like Figure 4-7 shows. Users may change the characters by typing
in the text box.

EzCad2 supports five types of text. (Figure 4-8)
When users select a type, a font list under that type will

appear to show all the available fonts. Figure 4-9 is the list of
TrueType.

Figure 4-10 is the list of Barcode Type.
Height:Height:Height:Height: the average height of characters

: Figure 4-11 shows the dialog box after clicking

this icon.

: When selected, the current text aligns left.

: When selected, the current text aligns

center.

: When selected, the current text aligns

right.
Bold:Bold:Bold:Bold: When selected, the current text become
bold.
Italic:Italic:Italic:Italic: When selected, the current text become
italic.
EEEEnablenablenablenable thethethethe samesamesamesame widthwidthwidthwidth character:character:character:character: make the
width of all characters the same
CharCharCharCharWidth:Width:Width:Width: the average width of characters
CharCharCharCharAngle:Angle:Angle:Angle: the degrees the characters incline
CharCharCharChar spacespacespacespace:::: the distance between characters
LinesLinesLinesLines space:space:space:space: the distance between rows
EEEEmptymptymptympty charcharcharchar widthwidthwidthwidth: the width of empty char

4-7 Character Properties

Figure 4-8 Types of Text

Figure 4-9 TrueTpye List
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4.7.24.7.24.7.24.7.2 CurveCurveCurveCurve texttexttexttext functionfunctionfunctionfunction

EzCad2 support curve text function, if the user draw text near enough from the curve,

the text will arrange along the curve. When current text is curve text, click , fig 4-12

will pop-up:

Figure 4-10 List of Barcode Type

Figure 4-11 Character Options
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mean text will be parallel with

the curve, as fig 4-13.

Fig 4-13 normal arrange

means text will be vertical with

the curve, as fig 4-14.

Fig 4-14 vertical arrange

means the base line of the text is superposition with the curve, as

fig 4-13.

means the top of the text is superposition with the curve, as

fig4-15.

Fig 4-12 curve text
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Fig 4-15 top arrange

means bottom of the text is superposition with curve, as fig 4-16.

Fig 4-16 bottom arrange

means middle of the text is superposition with curve, as fig 4-17.

Fig 4-17 middle arrange

means text stay on the curve freely along with the curve, the

position of the text is up to as fig 4-18.
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Base length 
Offset length 

Fig 4-18 freely arrange

put text on the other side of the curve, after this function, fig 4-13 will like fig 4-19.

Fig 4-19 put text on the other side of the curve

when put text on circle, we use this function.
Base angle: means the angle of the base line of the text.
Angle range limit: when we click it, no matter how many characters we input, system will

compress all the characters in the limit angle, as fig 4-20.
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Fig 4-20 limit the angle as 45

4.7.4.7.4.7.4.7.3333 CCCCircleircleircleircle TextTextTextText

EzCad2 supports circular text, after select in the figure 4-11, the text will align

according to the user definition circle diameter.
The demonstration graph in Figure 4-12 is according to
Figure 4-11 parameter making.
BaseBaseBaseBase aaaangle:ngle:ngle:ngle: The benchmark of the text aligning the circle.
AngleAngleAngleAngle rangerangerangerange limitlimitlimitlimit:::: When checked, no matter how much
chars that users type in, the text will be limited in the angle
range. (Figure 4-13)

Figure 4-13 Comparison of Two Texts (Limiting Angle is 45 degrees.)

Figure 4-12 Circle Text
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4.7.4.7.4.7.4.7.4444 BarcodeBarcodeBarcodeBarcode TextTextTextText

When users click the icon , a dialog box will be displayed as Figure 4-14 shows.

Figure 4-14 Barcode Text

1. SketchSketchSketchSketch MapMapMapMap
The sketch map is that the current barcode will look like.

2. BarcodeBarcodeBarcodeBarcode InformationInformationInformationInformation
The barcode explanation shows some information about the current barcode’s format,
and if users are not very clear with the format, it is recommended to read the tip first to
get to know what types of characters is valid.

3. TextTextTextText
This item refers to the text to be made into barcode. And if the characters users types in

the Text space is valid, there will be a cross selected in which shows the
current characters are valid for being made into a barcode.

4. ShowShowShowShow TexTexTexTextttt
Whether to show a corresponding text under the barcode (Figure 4-15)
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Figure 4-15 Show Text

HatchHatchHatchHatch：The text is hatched as the setting of hatch in the show text if the hatch is selected;
otherwise the hatching is the same as barcode.
Font:Font:Font:Font: The font of the current characters to be displayed
Width:Width:Width:Width: the width of the characters
Height:Height:Height:Height: the height of the characters
TextTextTextText OffsetOffsetOffsetOffset X:X:X:X: When selected and set up, the text displayed under the barcode will be
moved towards either the positive or the negative directions of X axis.
TextTextTextText OffsetOffsetOffsetOffset Y:Y:Y:Y: When selected and set up, the text displayed under the barcode will be
moved towards either the positive or the negative directions of Y axis.
TextTextTextText SpaceSpaceSpaceSpace:::: the space between characters

5. QuietQuietQuietQuiet:
Refer to the size of the barcode’s blank area, when let the barcode “Reverse” valid.

� One-Dimensional Barcode
This kind of barcode consists of barbarbarbar and spacespacespacespace one by one. The barcode information is
carried by different width and position of the barsbarsbarsbars and spacespacespacespace, and the information
volume they carry is decided by the width and the precision. Wider the barcode is, more
the barsbarsbarsbars and the spacespacespacespace included, and more information carried. This kind of barcode
technology can store information towards only Unidirection through permutation and
combination of the barsbarsbarsbars and the spacespacespacespace, and so it is called one-dimensional barcode.
Figure 4-16 shows a feature of parameter setting when a one-dimensional barcode is
chosen.
CheckNumCheckNumCheckNumCheckNum:::: This refers to whether the current barcode needs verify code. Users can
freely choose which barcode they would like to add verify code on, and users have the
decision whether to use the verify code or not.
Reverse:Reverse:Reverse:Reverse: This refers to whether to reverse the parts which should be marked into the
unexpected parts of an object. This function is used in some materials which appear
light color after the marking.
BarBarBarBar Height:Height:Height:Height: the height of the barcode
NarrowestNarrowestNarrowestNarrowest Width:Width:Width:Width: This refers to the width of unit barbarbarbar. Commonly a one-dimensional
barcode consists of barsbarsbarsbars with four types of width and spacespacespacespace with four types of width, 1
\ 2 \ 3 \ 4. The narrowest bar’s width indicates the width is 1 unit.
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Interchar space 

Figure 4-16 One-Dimensional Barcode Parameter

Setting
Figure 4-17 Characters’ Distance

IntercIntercIntercIntercharharharhar spacespacespacespace:::: It is prescribed that some barcodes have distance between characters. (e.g.
Code 39) This parameter is used to set this like Figure 4-17 shows.
UseUseUseUse InterInterInterInter HatchHatchHatchHatch Line:Line:Line:Line: If the facula diameter of laser bean is big, there will be a half facula
over boundaries after common hatch, then the code gun can not distinguish because actual
marking width is bigger than design width. So we specially design this hatch. The hatch line
is bow line and don’t have contour.
LaserLaserLaserLaser BeanBeanBeanBean Diameter:Diameter:Diameter:Diameter: The size of laser facula.
HatchHatchHatchHatch LineLineLineLine Distance:Distance:Distance:Distance: The space between two hatch lines
Scale:Scale:Scale:Scale:

Bar:Bar:Bar:Bar: setting the width of one bar.
Space:Space:Space:Space: setting the width of the space,

Quiet:Quiet:Quiet:Quiet:
Refer to the size of the barcode’s blank area, when let the barcode “Reverse” valid. The
actual size of the blank area is the multiple of the unit bar.

� Two-Dimensional Barcode

1. PDF417 Barcode

Figure 4-18 PDF417 Barcode Figure 4-19 Compress PDF417 Barcode
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PDF is the abbreviation of the Portable Data File. Figure 4-18 is the demonstration of
PDF417 Barcode and Figure 4-19 of the Compress PDF417 Barcode. Figure 4-20 is the
parameter setting of the PDF417 Barcode.

BarBarBarBar Height:Height:Height:Height: the height of the barcode
NarrowNarrowNarrowNarrowWidth:Width:Width:Width: This refers to the width of the unit bar.
LevelLevelLevelLevel: the Error-Checking Level of PDF417 barcode, from 0 to 8
LinesLinesLinesLines andandandand ColumnsColumnsColumnsColumns: the lines and Columns of PDF417 barcode

Figure 4-18 shows a feature of a barcode with the row’s number is four and the column’s is four.

Figure 4-20 PDF417 parameter

2. Data Matrix Barcode:
Data Matrix is a kind of two-dimensional barcode based on Matrix, and currently there are

two types: Ecc000-140 and Ecc200. EzCad2 supports Ecc200 at present.
Figure 4-21 shows the parameter setting of Data Matrix Barcode.

Figure 4-21 Data Matrix Barcode Parameter Setting Figure 4-22 Data

Matrix Barcode

Size

Figure 4-23 Data Matrix

Barcode Width

Data Matrix has various fixed size, and users can choose what they want. If the smallest
size is chosen, the system will automatically select the smallest frame to fit the all text users have
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typed.
NarrowNarrowNarrowNarrowWidth:Width:Width:Width: the width of the unit bar (Figure 4-23)

3. QRCODE Barcode:
QRCODE Barcode is two dimensional (2D) code format. The character set includes all

ASCII values. There are no size restrictions.
The figure 4-24 ，4-25， 4-26 are the parameter of QRCODE Barcode.

Figure 4-24 QRCODE Barcode Figure 4-25 QRCODE Barcode text setting

Figure 4-26 QRCODE Barcode Parameter Setting

4. USER DEFINE Code:
USER DEFINE Code is user can define code format by self. Figure 4-27 and figure 4-28 are

the demonstration of user defines code.
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Figure 4-27 USER DEFINE Code Parameter Setting

Figure 4-28 USER DEFINE Code

4.7.44.7.44.7.44.7.4 VariableVariableVariableVariable TextTextTextText

The function of variable text is available after is selected.

Variable Text is a disciplinary and dynamic text which can be customized during the operation.
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Figure 4-29 Variable text attributes

The adjacent character distance in current text character arrangement situation

What the adjacent character spacing's computation refers to is left side the

character right boundary to the right side character left boundary distance, see the figure 4-30:

Figure 4-30 Calculate spacing according to character boundary

What the adjacent character spacing's computation refers to is left side the

character center to the right side character center distance, see the figure 4-31:
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Figure 4-31 Calculate spacing according to character center

is the special array uses in the variable text array, when uses this array the time text

to change automatically, but 2.11 object property said the array will not change the text object, this
is the difference about these two array.

Inside the EZCAD2 international edition the variable text is a character string according to
successively the order by each kind of different real-time change text element. The user may
according to need to increase each kind of variable text element, may carry on the order of rank to
the text element.

After the user click “increases”, the system will display a dialog box as Figure 4-32 shows.
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Figure 4-32 Text element dialog box

Currently EzCad2 supports 9 types of variable text:
FixedFixedFixedFixed text:text:text:text: refers to the fixed invariable element in the operating process.
SerialSerialSerialSerial number:number:number:number: The system will change the text according to the fixed increment when in

the operating process.
DateDateDateDate Code:Code:Code:Code: When the operation is taking place, the system will automatically pick up the

date information from the computer as a new formed text.
Time:Time:Time:Time: When the operation is taking place, the system will automatically pick up the time

information from the computer as a new formed text.
TCP/IPTCP/IPTCP/IPTCP/IP communication:communication:communication:communication: When the operation is taking place, the system will pick up the text

from the network
SerialSerialSerialSerial communication:communication:communication:communication: When the operation is taking place, the system will pick up the text

from the serial port
File:File:File:File: The system will seriatim read what to be marked in the customized text file line by line.
Keyboard:Keyboard:Keyboard:Keyboard: Users can type text to be marked through keyboard when the marking is in

process.
SQLSQLSQLSQLdatabasedatabasedatabasedatabase:::: The system will seriatim read what to be marked in the database line by line.

FixedFixedFixedFixed texttexttexttext

The fixed text is refers to the fixed invariable element in the operation process.

Figure 4-33 Fixed text

ChangeChangeChangeChange LineLineLineLine charactercharactercharactercharacter:::: uses in variable text, can resolve the question about multi-text

must branch marking. When application, increases one change line character between two variable
texts, the software according to the change line character position automatic text branch. If many
texts need to divide into the multi-lines, only need in the behind where want to branch's text to
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increase one change line character.

The fixed text has a special option is , when chooses this item, the system uses

the current user name to replace the fixed text automatically.
Below explains with examples the situation needs to use in the fixed text the user name

function.
If the present must process one batch of work piece as shown in Figure 4-34, because the

worker is every day three number of runs in turn, in order to control the quality to need each
operator marks his own name, does not process the part in the work piece. Because only the
designer and the administrator have the jurisdiction of change processing document, the operator
is unable to change the processing document to increase own name, this time needs to use in the
fixed text the user name function.

The administrator must enable “You must enter and password before using” (see Chapter
2.6.7), then sets a user name and the password for each operator. The designer completes the
processing document which as shown in Figure 4-34, the last text sets the user name in the object
list. After like this each operator goes to work, after opening EZCAD2, must input own user name
and the password, in processes this document time, the system alters to automatically the last text
operator's name.

Figure 4-34 the processing example has the user name in the fixed text

SerialSerialSerialSerial numbernumbernumbernumber

Serial number text is a text which is changed according to the fixed increment when in the
operating process.
When selected, a serial number parameter setting will automatically appear in the variable text
dialog box. (Figure 4-35)
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Figure 4-35 Serial number parameter definition

Mode:Mode:Mode:Mode: The mode current series number used, see the figure 4-36.

Figure 4-36 Serial number mode

Dec:Dec:Dec:Dec: Series number carry according to decimal system, the effective character is from zero to
nine.

HEX:HEX:HEX:HEX: Series number carry according to capital letter hexadecimal system, the effective
character is from A to F

hex:hex:hex:hex: Series number carry according to small letter hexadecimal system, the effective
character is from a to f

UserUserUserUser define:define:define:define: The series number carry defines according to user define system, after selecting,
the system will display a dialog box like Figure 4-37 shows.
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Figure 4-37 User define other number system dialog box

The user can define carry ways discretionary between 2 to 64, only needs to define the max
number, and then revises each serial number correspondence the text
StartStartStartStart SNSNSNSN:::: This item indicates the first serial number to be marked at the present
CurrentCurrentCurrentCurrent SNSNSNSN:::: the serial number to be marked at the present
Limit:Limit:Limit:Limit: when mark the limit serial number, it will back to start serial number automatically
IncrementIncrementIncrementIncrement:::: the increment of the current serial number. The value may be plus or minus
When the increment is “1”, and if the starting serial number is 0000, there will be an increment
“1” added on the previous serial number. For example, 0000, 0001, 0002, 0003 … 9997, 9998,
9999, and when it comes to 9999, the system will be back to 0000 automatically.
When the increment is “5”, and if the starting serial number is 0000, the serial number is: 0000,
0005, 0010, 0015, 0020, 0025 …
Others can be analogized by this.
MarkMarkMarkMarkssss per:per:per:per: the marked number. This item indicates how many times every serial number is
marked before changing.
Current num: the marking time of current serial number, when marking number equals to marks
per, it will turn to 0 automatically

if click it, software won’t mark special number in special digit.

won’t mark numbers end with 4, * means any digit.

Reset: The number will become the start SN in the set time.
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DateDateDateDate CodeCodeCodeCode

When the operation is taking place, the system will automatically pick up the date
information from the computer as a new formed text.

When selected, a date parameter definition will be shown in the dialog box automatically. As
Figure 4-38 shows, users can directly choose the type they prefer.

Figure 4-38 Data parameter definition

YearYearYearYear－ 2008:2008:2008:2008: Use computer clock's current year for corresponding text, the form is four
characters.

YearYearYearYear－ 08:08:08:08: Use computer clock's current year for corresponding text, the form is two
characters: latter two digits are effective of the year.

MonthMonthMonthMonth－ 07:07:07:07: Use computer clock's current month for corresponding text, the form is two
characters.

DayDayDayDay－04:04:04:04: Use current computer clock's each month's date for corresponding text, the form is
two characters.

DayDayDayDay－ 186:186:186:186: The use current computer clock this day takes the corresponding text from
January 1 number of days, the form is three charactes. (What 001 represent is on January 1 , what
002 represent is on January 2, what 003 represent is on January 3, ex analogia)

DayDayDayDay ofofofof weekweekweekweek－5:5:5:5: Use current computer clock's week date for corresponding text, the form is
one character

WeekWeekWeekWeek ofofofof yearyearyearyear－27:27:27:27: The use current computer clock this day is this year's several week for
the text which corresponds, the form is two characters (from January 1 to January 7 is 01, from
January 8 to January 14 is 002, ex analogia)

Date:Date:Date:Date: When system read computer clock's date, needs to add on the the displacement date is
the finally date, this function mainly uses in the work piece processing having the production date
and guaranteeing nature date professions and so on food.

UUUUser-definedser-definedser-definedser-defined monthmonthmonthmonth charactercharactercharactercharacter:::: When selected the month as the corresponding text, the
Figure 4-39 will be shown. Users can define the month character, changes to other characters that
no longer uses the digit which the software defaulted, only needs double-clicks the selected month,
input the month other characters, finally the month which shown on the software workspace is
with the input character.
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Figure 4-39 User-defined month character

click it, follow dialog will show, user could define year as user need

TimeTimeTimeTime

When the operation is taking place, the system will automatically pick up the time
information from the computer as a new formed text.

When selected, a time parameter definition will be shown in the dialog box automatically. As
Figure 4-40 shows, users can directly choose the type they prefer.

Figure 4-40 Time section

HourHourHourHour－24:24:24:24: Use current computer clock's hour for the corresponding text, the time format is
24-hour-setting

HourHourHourHour－12:12:12:12: Use current computer clock's hour for the corresponding text, the time format is
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12-hour-setting
Minute:Minute:Minute:Minute: Use current computer clock's minute for the corresponding text.
Second:Second:Second:Second: Use current computer clock's second for the corresponding text.
TimeTimeTimeTime Section:Section:Section:Section: Divides into 24 time sections one day of 24 hour, the user may define each

time section is a text. This function mainly uses in the work piece the processing needing to have
the number of runs information.

TCP/IPTCP/IPTCP/IPTCP/IP communicationcommunicationcommunicationcommunication

When the operation is taking place, the system will pick up the text from the network.
Notice:Notice:Notice:Notice: The network interface in here is the network interface uses in TCP/IP agreement.
When the user selected the “TCP/IP communication”, the parameter defines will display

automatically in the dialog box, see the figure 4-41:

Figure 4-41 TCP/IP communication parameter definition

IPIPIPIPAddress:Address:Address:Address: select the IP address which from reads the data
Port:Port:Port:Port: select the port the TCP/IP communication used
Command:Command:Command:Command: When the system processes to this text object, the system through the

network interface to transmit this order character string to a computer assigned the IP address,
request the computer sends the character string needs to process at present, the system will not
return until the computer replied, after the response of the computer, the system will process the
returns text automatically.

Unicode:Unicode:Unicode:Unicode: After choosing this option, the system to the computer transmission which and
the read character is the Unicode form, otherwise is the ASCII form.

TheTheTheThe followingfollowingfollowingfollowing exampleexampleexampleexample showedshowedshowedshowed howhowhowhow totototo useuseuseuse thisthisthisthis functionfunctionfunctionfunction::::
Now has a customer to process 10000 work pieces, on the work piece the marking content is

a text, but each work piece must process the text content is dissimilar, therefore, before each work
piece processing, must real-time read the processing content through the network from the local
area network a computer server (IP: 192.168.0.1 port is 1000) on.

1． Open ezcad2 to establish a text object, adjust the text size, the position and the
processing parameter.

2． Choice the text object, select the “enables variable text”, click the “increase” button, the
system will spring a Figure dialog box as 4-32, select TCP/IP communication, set the
network interface parameter, the IP address parameter fills in server computer's IP, here
is 192.168.0.1; the port parameter sets to use in the communication the port number, here
is 1000, the network interface parameter must identically with the server computer on ,
otherwise it will cause to be unable communication.

3． Set the command is TCP: Give me string.(This command may for the random server
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definition command)
4． After closing the dialog box, click the application button.
5． Click F2 to start to process, the computer will send the command “TCP: Give me string”

to the server immediately through the net mouth, and waited for that the server will
return.

6． After the server discovered the network interface receives the command is “TCP: Give
me string”, reads the database immediately to obtain the text which the current must
process, then gives the local computer through the network interface reply.

7． After the local computer obtains the text which must process, changes the processing
data to transmit immediately to the marking board.

8． After the marking board receives the processing data, control the machining to mark the
work piece immediately.

Flow chart as shown in Figure 4-42:

Figure 4-42: TCP/IP communication flow chart

SerialSerialSerialSerial communicationcommunicationcommunicationcommunication

When the operation is taking place, the system will pick up the text from the serial port.
When the user selected the “Serial communication”, the parameter defines will display

automatically in the dialog box, see the figure 4-43
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Figure 4-43 Serial communication parameters

Port:Port:Port:Port: the port which computer and peripheral equipment connection used
BaudRate:BaudRate:BaudRate:BaudRate: the BaudRate which the serial communication used
DataBits:DataBits:DataBits:DataBits: the DataBits which the serial communication used
StopBits:StopBits:StopBits:StopBits: the digits of StopBits of which the serial communication used
Parity:Parity:Parity:Parity: select the digits of Parity which the serial communication used
Command:Command:Command:Command: When the system processes to this text object, the system through the serial port

to transmit this order character string to a peripheral equipment, request the peripheral equipment
sends the character string needs to process at present, the system will not return until the
peripheral equipment replied, after the response of the peripheral equipment, the system will
process the returns text automatically.

Unicode:Unicode:Unicode:Unicode: after choosing this option, the system to the computer transmission which and the
read character assigns is the Unicode form, otherwise is the ASCII form.

TheTheTheThe followingfollowingfollowingfollowing exampleexampleexampleexample showedshowedshowedshowed howhowhowhow totototo useuseuseuse thisthisthisthis functionfunctionfunctionfunction：
Now has a customer to process 10000 work pieces, on the work piece the mark content is a

text, but each work piece must process the text content is dissimilar, therefore, before each work
piece processing, must real-time through the serial port (On serial port parameter establishment
server: the BaudRate is 15200, the DataBits is 8, the StopBits is 1, the Parity is NO)the content
which the read must process to other server on.

1. Open ezcad2 to establish a text object, adjust text size, the position and the processing
parameter.

2. Choice the text object, select the “enables the variable text”, click the “increase” button,
the system will spring a Figure dialog box as 4-32, select Serial communication, the
setting of serial port parameter must with server's serial port parameter correspondence
(the BaudRate is 15200, the DataBits is 8, the StopBits is 1, the Parity is NO), the port
for current the port number which uses with it connected server, the serial port parameter
must establish identically with the server computer on

3. Set the command is COM: Give me string. (This command may for the random server
definition command).

4. After closing the dialog box, click the application button.
5. Click F2 to start to process, the computer will send the command “COM: Give me

string” to the server immediately through serial port and wait for that the server will
return.

6. After the server discovered the serial port receives the command is “COM: Give me
string”, reads the database immediately to obtain the text which the current must process,
then gives the local computer through the serial port reply.

7. After the local computer obtains the text which must process, changes the processing
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data to transmit immediately to the marking board.
8. After the marking board receives the processing data, control the machine to mark the

work piece immediately.
Flow chart as shown in Figure 4-44:

Figure 4-44 Serial communication flow chart

FileFileFileFile

Txt files and Excel files are supported now.
1．Txt files

When select TXT file, a dialog box as
Figure 4-45 shows will be displayed
to ask for the file’s name and the
current text’s line number.

AutoAutoAutoAuto reset:reset:reset:reset: If checked, the line
number will change to 0 automatically
when reach the last line. The next
mark will start from the first line
again.

ReadReadReadRead allallallall lines:lines:lines:lines: When processes to the text document direct read entire document.
2．Excel files

Figure 4-45 TxT document parameter definition
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Figure 4-46 Excel document parameter definition

We have to appoint the file name, Field name, Line number to tell the software which cell in
the excel table will be mark.

FileFileFileFile name:name:name:name: The text string of the first row in the datasheet1. This parameter indicates which
column will be marked.

KeyboardKeyboardKeyboardKeyboard

The keyboard element is the text which must process from the keyboard entry by the user,
when select the keyboard element, a dialog box as Figure 4-47-a shows will be displayed to ask
for the user set the keyboard element parameter.

FFFFixedixedixedixed charcharcharchar countcountcountcount:::: user must

input string with digit equals to this
count

PromptPromptPromptPrompt: In the processing, the

system will spring the input dialog
box which ask for the user input the processing text when meets the keyboard variable text, like
the figure 4-47-b shows, this time the user direct by-hand input the text.

SetSetSetSet PenPenPenPen Param:Param:Param:Param: When selected, we can get power, speed, frequency from the keyboard entry,
only through setting pen*.power, pen*.speed or pen*.freq. The “*” is number of pen.

The keyboard element function uses frequently in this kind of situation when the processing
needs the real-time input to the processing content. If the customer present need processes one
batch of work pieces, on each work piece is printed with a bar code, when processing needs the
user with the bar code scanning gun real-time scans the work piece to read the content on the bar
code, then with laser to mark to the work piece assigns in the position, at this time can use the
keyboard element function. At the processing time system springs like the figure 4-47-b shows the
dialog box, the operator with the bar code scanning gun scanning bar code work piece on, the bar
code scanning gun inputs the read content to the dialog box inside and closes it automatically, then
the system will start to process the content read a moment ago automatically .

Figure 4-47-a Keyboard element parameter
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Figure 4--47-b Keyboard input text dialog box

4.84.84.84.8 BitmapBitmapBitmapBitmap

To add a photo, users may select command “Bitmap” in the Draw Menu or click icon in

the Toolbar

Figure 4-51 Add a photo

Then the system will pop a dialog box as Figure 4-51 shows to open a graphic file.

The current supported graphic file formats are: Bmp；Jpeg, Jpg；Gif；Tga；Png；Tiff, Tif；
ShowShowShowShow Preview:Preview:Preview:Preview: When users select a graphic file, there will be a preview displayed in the

dialog box.
PutPutPutPut totototo centercentercentercenter:::: put the photo’s center in the origin

When finishing adding a photo, a “Bitmap” parameter setting will appear in the Property



EzCad2UNI User’s Manual

46 All rights reserved

Toolbar as Figure 4-52 shows.

DynamicDynamicDynamicDynamic file:file:file:file: whether to reread files when in process.
FixedFixedFixedFixed DPI:DPI:DPI:DPI: When selected, the system will fasten the

unfixed DPI of dynamic photo. The higher the DPI’s level is,
the closer the dots gather; and the photo’s precision is better,
then the marking time is longer.

DPI:DPI:DPI:DPI: dot per inch; 1 inch is about 25.4 millimeters
FixedFixedFixedFixed SizeSizeSizeSize XXXX:::: When checked, the width of the dynamic

photo will be preserved in an appointed size, and if unchecked,
the photo’s width will be the original size of the photo.

FixedFixedFixedFixed SizeSizeSizeSize YYYY:::: When checked, the height of the dynamic
photo will be preserved in an appointed size, and if unchecked,
the photo’s height will be the original size of the photo.

FixedFixedFixedFixed positionpositionpositionposition:::: the benchmark the dynamic photo based
on while in size changing

Image Manipulation:
InvertInvertInvertInvert:::: run negative effect on photos (Figure 4-53)

Figure 4-53 Invert Effect (Left is original.)

GrGrGrGraaaay:y:y:y: change color photos into grey of level 256 (Figure 4-54)

Figure 4-52 Bitmap Parameter
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Figure 4-54 Color and Grey (Left is original.)

DitherDitherDitherDither:::: This effect is similar with the function “Grey Adjust” in Adobe PhotoShop. It uses
color black and white to simulate grey image, so as to achieve a grey effect with dots arranged in
different densities, as Figure 4-55 shows. (The white bar in the photo was caused by display,
which will not be marked.)

Figure 4-55 Dither

Click the “Expand” button to run the “Bitmap” dialog box. (Figure 4-56)
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Figure 4-56 Bitmap Dialog Box

LightLightLightLightenenenen:::: adjust the current image's brightness and contrast values.
Scan Mode:
BidirectionalBidirectionalBidirectionalBidirectional Scan:Scan:Scan:Scan: the scan mode is bidirectional when in marking process (Figure 4-57)

Figure 4-57 Left is unilateral scan; right is bidirectional.

Mark Mode:
DrillDrillDrillDrill mode:mode:mode:mode: whether the laser is kept on or restricted in appointed time for each dot’s marking

when in process
AdjustAdjustAdjustAdjust Power:Power:Power:Power: whether the laser’s power is adjusted according to each dot’s grey level when

in process
Expand Parameter: Figure 4-58
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YYYY Scan:Scan:Scan:Scan: The scan will run along Y axis line by line.

ScScScScanananan linelinelineline Increment:Increment:Increment:Increment: This item indicates whether to scan line by line or skip some
lines. This function may quicken the marking speed when in low precision marking requirement.

DisableDisableDisableDisable MarkMarkMarkMark LowLowLowLow GrayGrayGrayGray PointPointPointPoint: This item indicates that every point is marked or only marking

bigger gray points. This function may quicken the marking speed when in low precision marking
requirement.

Line feed malposition: The point isn’t aligned between two adjacent rows, but the point is

aligned with the position which is the middle of two points in the previous line, to avoid the trace
of marking.

Gray-Power figure: For improving marking results, can modify some of the gray scale

corresponds to the power

4.94.94.94.9 VectorVectorVectorVector FileFileFileFile

To input a vector file, users can select command “Vector File” in Draw Menu or click

icon .

Figure 4-58 Scan Parameter
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Figure 4-59 Input a Vector File

There will be a dialog box pop up to ask for the vector file to be inputted.

The current supported vector file formats are: PLT；DXF；AI；DST; SVG; NC
NOTE:NOTE:NOTE:NOTE: IfIfIfIf thethethethe vectorvectorvectorvector filesfilesfilesfiles includesincludesincludesincludes colorcolorcolorcolor informationinformationinformationinformation (when(when(when(when drawdrawdrawdraw itititit bybybyby imageimageimageimage softwaresoftwaresoftwaresoftware

likelikelikelike CorelDraw,CorelDraw,CorelDraw,CorelDraw, AutoCAD,AutoCAD,AutoCAD,AutoCAD, PhotoshopPhotoshopPhotoshopPhotoshop andandandand sosososo on),on),on),on), EzcadEzcadEzcadEzcad cancancancan distinguishdistinguishdistinguishdistinguish thethethethe colorcolorcolorcolor
automatically.automatically.automatically.automatically. ThenThenThenThen useruseruseruser cancancancan pickpickpickpick thethethethe objectobjectobjectobject accordingaccordingaccordingaccording totototo thethethethe colorcolorcolorcolor orororor penpenpenpen (see(see(see(see ChapterChapterChapterChapter 4.12)4.12)4.12)4.12)
andandandand setsetsetset markingmarkingmarkingmarking parametersparametersparametersparameters (see(see(see(see ChapterChapterChapterChapter 10.110.110.110.1 ““““colorcolorcolorcolor””””,,,, ““““penpenpenpen””””))))
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When users have opened a vector file, a vector file
parameter setting as Figure 4-60 shows will appear.

4.104.104.104.10 Time-lapserTime-lapserTime-lapserTime-lapser

To input the Time-lapser, users can select command

“Time-lapser” in Draw Menu or click icon .

When selected, there will be a property setting of the
time-lapser displayed in the Property Toolbar as Figure
4-61 shows.

WaitingWaitingWaitingWaiting time:time:time:time: The marking will pause until the
specific time has passed.

4.114.114.114.11 InputInputInputInput PortPortPortPort

To check the Input signal, users can select command “Input Port” in the Draw Menu or click

icon .

When selected, there will be an input port property
setting appearing in the Property Toolbar as Figure 4-62
shows.

I/OI/OI/OI/O ControlControlControlControl ConditionConditionConditionCondition: The software will pause
until the input signal is the same as the I/O control
condition.

MessageMessageMessageMessage:::: If checked, the software will pop up a
message box to info the user. The message text can be
custom defined.

4.124.124.124.12 OutputOutputOutputOutput PortPortPortPort

To output signal, users can select command “Output Port” in the Draw Menu or click the

icon .

When checked, there will be an output port property setting appearing in the Property Toolbar
as Figure 4-63 shows.

Figure 4-60 Vector File Parameter Setting

Figure 4-61 Waiting Time

Figure 4-62 Input Parameter
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: This icon indicates that the system will export a

high-level voltage (TTL compatible) when the operation is
taking place at the current output port.

: This icon indicates that the system will export a

low-level voltage (TTL compatible) when the operation is taking
place at the current output port.

: This icon indicates that the system will export a

fixed-level.

: This icon indicates that the system will export a pulse.

4.134.134.134.13 SelectSelectSelectSelect

Icon on the top of the Draw Toolbar is used to select object. The pressed-down state

of this icon indicates that the current command is “select”. Now, you can use mouse to click object

in the workspace to select it. 4.14 Node Editing

Figure 4-63 Output Parameter
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ChapterChapterChapterChapter 6666 ViewViewViewView MenuMenuMenuMenu

6.16.16.16.1 ZoomZoomZoomZoom

The Toolbar of the zoom Menu is , and there are six
types for different requirements.

: This item is used to fill the whole view area with the appointed area. Users may use
mouse to select rectangle area to zoom in. If pressing the right button of the mouse, the current
view will zoom out for one time with the mouse pointer’s position as the center; and if pressing
the left button of the mouse, the current view will zoom in for one time with the mouse pointer’s
position as the center.

: To move the current view

: Zoom in

: Zoom out

: Fill the whole view area with all the objects

: Fill the whole view area with the whole workspace
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ChapterChapterChapterChapter 10101010 MarkingMarkingMarkingMarking

Figure 10-1 is the Marking Properties Table.

10101010.1.1.1.1 PenPenPenPen ListListListList

In EzCad2, every document file has 256 pens,
0 to 255 numbered, and they are located in the top
of the Marking Properties Table. Each pen is
corresponding to a group of marking parameter and
the parameter base’s name is after the color.

: This item indicates that objects with
selected pen’s number will be marked. Users may
customize the color by double-clicking the color
sticker.

: This item indicates that the current object
has not been marked with a pen’s number, and it
will not be marked.

Color: the current pen’s color
Apply Parameter Button: The buttons show as

Figure 10-2
When pressed the button, the pen number of

the current object will be changed to the one that
the color stands for.

When pressing the right button of the mouse, a
shortcut menu will appear as Figure 10-3 shows.

Figure 10-2 Button to apply parameters

Figure 10-3 Shortcut Menu

Figure 10-1 Marking Properties Table
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10101010.2.2.2.2 MarkingMarkingMarkingMarking ParameterParameterParameterParameter BaseBaseBaseBase

Marking Parameter Base is a base filled with all marking parameters which have been set by
users already.

YAG: YAG indicates that the current Marking Parameter is for YAG laser machine, and if not,
it is for CO2 laser machine.

Select param from library: When press this button, a dialog will pop up as figure 10.2-1
shows. We can save the parameters to disk files, or to delete parameters from files.

LoopLoopLoopLoop count:count:count:count: loop times to mark an object
Speed:Speed:Speed:Speed: the current marking speed
PowerPowerPowerPower //// Current:Current:Current:Current: In CO2 mode, this item indicates the power percentage of the current

marking parameter, and 100% refers to the biggest power of the laser equipment. In YAG mode,
this item indicates the current of the Q-switch.

Frequency:Frequency:Frequency:Frequency: the laser machine’s frequency in the marking parameter
QQQQ pulsepulsepulsepulse Width:Width:Width:Width: the high-level’s time of the Q pulse if the laser equipment is Q-switch YAG

laser machine
StartStartStartStart TC:TC:TC:TC: When the scanhead has to execute a mark command, the scanner mirrors first have

to be accelerated up to the defined marking speed. In the beginning of the movement, the laser
focus moves very slowly which may result to burn-in effect at the start point. To avoid this, We
insert a delay (StartStartStartStart TCTCTCTC) at the beginning of each mark command. When the laser eventually turns
on, the mirrors have already reached a certain velocity. However, if this value is too large, the first
part of the vector will be cut off. Also negative value is supported.

LaserLaserLaserLaser OffOffOffOff TCTCTCTC: The delay time of the laser shutting down after marking finished. Proper time
can wipe off the burn-in effect at the end. This value cannot be negative.

EndEndEndEnd TC:TC:TC:TC: The EndEndEndEnd TCTCTCTC parameter is used to control how long the software will wait at the
end of a series of vectors. The wait is required because the software is always "ahead" of the
hardware and must wait for the hardware to catch up. This delay applies to the end of all vectors
in which the laser is to be turned off after execution.

PolygonPolygonPolygonPolygon TCTCTCTC:::: tttthehehehe PolyPolyPolyPolygongongongon TCTCTCTC parameter is used to control how long the software will wait
at vector connection points. The wait is required due to the lag time between the software/DAC
position and the actual hardware/mirror position. This timer applies to all vectors whose endpoint
is also the start point of the next vector (polygon connection points). In other words, this timer
applies to end of all vectors in a series of connected vectors, except for the last one (the end of last
one is controlled by the EndEndEndEnd TCTCTCTC parameter). The three connected points in a square or the
intermediate connection points in a polyline circle are examples of points the PolyPolyPolyPolygongongongon TCTCTCTC
parameter can effect. The starting point of the square is controlled by StartStartStartStart TCTCTCTC parameter. The
last corner of the square is controlled with the EndEndEndEnd TCTCTCTC timer.

Clicking “Advanced” will prompt an advanced parameter dialog box as Figure 10-5 shows.
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JumpJumpJumpJump Speed:Speed:Speed:Speed: set a jump speed of the scanner
for the current parameter

JumpJumpJumpJump PositionPositionPositionPosition TCTCTCTC |||| JumpJumpJumpJump DistDistDistDist TC:TC:TC:TC: After
each jump movement, the system will delay some
time then execute the next command. The actual
delay time is calculated by the following formula:
TotalTotalTotalTotal delaydelaydelaydelay ==== (Jump(Jump(Jump(Jump DistanceDistanceDistanceDistance *Jump*Jump*Jump*Jump DistDistDistDist TC)TC)TC)TC) ++++

JumpJumpJumpJump PositionPositionPositionPosition TCTCTCTC
EndEndEndEnd compensate:compensate:compensate:compensate: Only when in high-speed

operation or this parameter need not to be set. This
parameter is used to mark a little bit more as an
ending increment at the end of an operation.
Negative value is supported.

AccAccAccAcc Distance:Distance:Distance:Distance: In those applications that
require laser marking without variation of intensity,
we have to add an accelerated segment before the
start point to reach the homogenous marking
results.

PointPointPointPoint Time:Time:Time:Time: This parameter is used to set the
marking time if there are dot objects.

VectorVectorVectorVector pointpointpointpoint mode/Pulsemode/Pulsemode/Pulsemode/Pulse perperperper point:point:point:point: Marking the vector graph using point mode, and force
the pulse number while marking each point

YAGYAGYAGYAG optimizeoptimizeoptimizeoptimize mode:mode:mode:mode: While marking on the high reflection material using YAG laser,
optimize the hatch arithmetic. Note: the function is used to resolve the irregular lines when
marking on the high reflection material using YAG laser. If you want to use this function, you
must connect the PWM signal to the pulse modulate signal of the Q-switch.

Now let’s take it into practice:

Mark a rectangle with size 40×20 and fill it with the following parameters: MarkMarkMarkMark ContourContourContourContour////
EdgeEdgeEdgeEdge offsetoffsetoffsetoffset=0 //// LineLineLineLine DistanceDistanceDistanceDistance =1.0 ////HatchHatchHatchHatchAngleAngleAngleAngle= 0 //// UnidirectionalUnidirectionalUnidirectionalUnidirectional hatchhatchhatchhatch

Set the marking parameters like this:

Parameter Name: XX ---- the name users customize (easy to understand it’s means.);
Loop count: 1;
Marking Speed: XX ---- the speed users need;
Jump Speed: XXX ---- the jump speed users customize (It is suggested to use 1200 –2500.);
Power Percentage: 50%;
Frequency: 5KHZ;
Start TC: 300;
End TC: 300;
Polygon TC: 100;
Jump Position TC: 1000;
Jump Distance TC: 1000;

Figure 10-5 Advanced
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End compensate: 0;
Acc. Distance: 0;
There may be several results to mark this hatched rectangle.
Case #1: The hatch-lines and the border are separated. (Figure 10-6) This is because the StartStartStartStart

TCTCTCTC Value is too big, and it needs to be smaller.

Figure 10-6 Case #1 Figure 10-7 Case #2

Case #2: The hatch-lines and the border are intersected (burn-in effect). (Figure 10-7) This is
because the StartStartStartStart TCTCTCTC Value is too small, and it needs to be higher.

Case #3: Uniform result. (Figure 10-8)

Figure 10-8 Case #3 Figure 10-9 Case #4

Different manufacturers use different Laser sources and scanner (gavlo), so the performances
are also different. Sometimes when however users modify the StartStartStartStart TCTCTCTC, the hatch-lines and the
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border cannot be superposed. Here users need to set the AccAccAccAcc DistanceDistanceDistanceDistance Parameter (Values from
0.05 to 0.25). But this may cause the 4th case: the hatch-lines are beyond the border, as Figure
10-9 shows. Users may increase the StartStartStartStart TCTCTCTC Value or lower the AccAccAccAcc DistanceDistanceDistanceDistance Parameter, and if
the two parameters are adjusted well, there will be a perfect result.

���� Adjust EndEndEndEnd TCTCTCTC::::
Still mark the hatched rectangle mentioned above
Here are three possible cases about the hatch-lines and the border’s relative positions.
Case #1: The fill-lines and the border are separated, as Figure 10-10 shows. This is because

the EndEndEndEnd TCTCTCTC is too short, and users need to raise it.

Figure 10-10 Case #1 Figure 10-11 Case #2

Case #2: Burn-in effect as Figure 10-11 shows. This is because the EndEndEndEnd TCTCTCTC is too long, and
users need to shorten it.

Case #3: Perfect result as Figure 10-12 shows.
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Figure 10-12 Case 3 Figure 10-13 Case 4

Different manufacturers use different Laser sources and scanner(gavlo), so the performances
are also different. Sometimes when however users modify the EndEndEndEnd TCTCTCTC,,,, the hatch-lines and the
border cannot be superposed. Here users need to set the EndEndEndEnd CompensateCompensateCompensateCompensate (Values from 0.05 to
0.25). But this may cause the 4th case: the hatch-lines are beyond the border, as Figure10-13
shows. Users should lower the EndEndEndEnd CompensateCompensateCompensateCompensate to reach the perfect result.

� Adjust JumpJumpJumpJump PositionPositionPositionPosition TCTCTCTC |||| JumpJumpJumpJump DistDistDistDist TCTCTCTC ::::
Below is the adjust steps:
Set the two Jump TC items’ values (Position TC value and Distance TC value) as 0 and then

mark the rectangle.
If the start segment and ending segment of the hatch-line are bent, users need to increase the

two Jump TC’s values until there is no bend appearing.
Note:Note:Note:Note: TheTheTheThe JumpJumpJumpJump TCTCTCTC isisisis tootootootoo bigbigbigbig maymaymaymay influenceinfluenceinfluenceinfluence markingmarkingmarkingmarking efficiencyefficiencyefficiencyefficiency.... TheTheTheThe scannerscannerscannerscanner (gavlo)(gavlo)(gavlo)(gavlo)

havehavehavehave betterbetterbetterbetter performanceperformanceperformanceperformance,,,, thethethethe lowerlowerlowerlower thethethethe twotwotwotwo JumpJumpJumpJump TCTCTCTC’’’’ssss valuevaluevaluevalue is.is.is.is.

� Adjust PolygonPolygonPolygonPolygon TCTCTCTC::::
If mark a rectangle with size 40×20, you may find three possible results about the rectangle’s

corners:
Case #1: As Figure 10-14 shows, it is changed into arc angle which should be right angle, and

this is because the PolygonPolygonPolygonPolygon TCTCTCTC is too short, here users need to raise the value.

Figure 10-14 Case #1 Figure 10-15 Case #2

Case #2: As Figure 10-15 shows, although the right angle is what it should be, the corner of
the angle is heavy marked, and this is because the Polygon TC is too long, here users need to
shorten the value.

Case #3: As Figure 10-16 shows, it is right angle and there is no heavy marking. This is the
result we want.
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Figure 10-16 Case #3

When finish setting these parameters already, you may start to mark. It is recommended that
users had better not modify the parameters which have been adjusted well. If they were changed,
the result would be changed too.

Users can use the same way to set other parameters and save them in the parameter list. By
doing this, users can reduce the repeated works and raise the work efficiency.

10101010.3.3.3.3 MarkMarkMarkMark-Control-Control-Control-Control BarBarBarBar

The Mark-Control Bar is located at the bottom of the main interface window, as Figure 10-17
shows.

Figure 10-17 Mark-Control Bar

RedRedRedRed:::: This item is used to mark the frame of the object without laser output so that users are
convenient to orient the workpiece. This function is available in those laser machines which have
guide light.

Key “F1” is the shortcut key of this function for guide light show.

Mark:Mark:Mark:Mark: to execute marking

Key “F2” is the shortcut key of this function.

Continuous:Continuous:Continuous:Continuous: mark the objects repeatly until user stop the mark
MarkMarkMarkMark Selected:Selected:Selected:Selected: only those selected objects would be marked
PartPartPartPart:::: the total counts that the mark command has been executed
TotalTotalTotalTotal:::: The total counts that the mark command should be executed. The value would

decrease 1 automatically after the mark command has been executed each time. It is unavailable
under the mode of Continuous Marking. When in marking process, if the amount number is more
than 1, the marking operation will not stop until the marking number is 0.

Parameter:Parameter:Parameter:Parameter: machine parameter
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Key “F3” is the shortcut key of this function.

10101010.4.4.4.4 MachineMachineMachineMachine ParametersParametersParametersParameters

10.4.110.4.110.4.110.4.1 FieldFieldFieldField ParameterParameterParameterParameter
See Figure 10-18

Figure 10-18 Area Parameter

FieldFieldFieldField:::: the widest range for marking
GavloGavloGavloGavlo 1=x:1=x:1=x:1=x: the track of gavlo 1 uesd as the X axis
GavloGavloGavloGavlo 2=x:2=x:2=x:2=x: the track of gavlo 2 uesd as the X axis
OffsetOffsetOffsetOffset X:X:X:X: The offset distance on X direction of scanhead.
OffsetOffsetOffsetOffset Y:Y:Y:Y: The offset distance on Y direction of scanhead.
UseUseUseUse thethethethe correctedcorrectedcorrectedcorrected file:file:file:file: Use the correction file generated by our CorFile.exe soft.
NegateNegateNegateNegate:::: the opposite direction of the current gavlo

This item refers to the distortional correction coefficient, and the default
value is 1.0 (range from 0.875 – 1.125). If your design is as Figure 10-19 shows but the marked
work is Figure 10-20 or Figure 10-21, you will have to increase the coefficient on the X axis
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direction for Figure 10-20 and lower the coefficient on the X axis direction for Figure 10-21.

Figure 10-19 Your Design

Figure 10-20 Marked Work

Figure 10-21 Marked Work

This item indicates the parallelogram correction coefficient, and the default is 1.0 (range

from 0.875 – 1.125). If your design is as Figure 10-19 shows but the marked work is Figure 10-22,
you will have to adjust this parameter to correct it.

Figure 10-22 Marked Work

ScaleScaleScaleScale:::: It refers to the flex percentage, and the default is 100%. This parameter will be
adjusted when the trim size marked is different from the setting size. If the trim size is smaller
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than the designed one, users can raise this parameter; if the trim size is bigger than the designed
one, users can lower this parameter.

NoteNoteNoteNote:::: If there are some distortions with the Laser scanner (gavlo), users should firstly adjust
the distortions and then the flex percentage.

When setting scale, we may press the button ，and a dialog will pop up just like figure

10-23.

Figure 10-23 Set the scale

GoalGoalGoalGoal markmarkmarkmark size:size:size:size: the size set in the software.
RealRealRealReal markmarkmarkmark size:size:size:size: the measured size of the object that have been marked on the workpiece.
The software will calculate the scale automatically according to these two values.
AfterAfterAfterAfter markmarkmarkmark GoGoGoGo to:to:to:to: The gavlo jump to the appointed position when finishing marking
password:password:password:password: after set the password ,we must input it can enter the Param Dialog Box.

10.4.210.4.210.4.210.4.2 LaserLaserLaserLaser ControlControlControlControl ParameterParameterParameterParameter
See Figure 10-24:
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Figure 10-24 Laser Parameter

LaserLaserLaserLaser type:type:type:type:
Co2:Co2:Co2:Co2: It indicates that current laser size is Co2 laser.
YAG:YAG:YAG:YAG: It indicates current laser size is YAG laser.
FiberFiberFiberFiber:::: It indicates that current laser size is fiber laser.
SPI_G3:SPI_G3:SPI_G3:SPI_G3: It indicates that current laser size is SPI laser.
Note: this function only support USBLMC control card.

PWM:PWM:PWM:PWM:
EnableEnableEnableEnable PWMPWMPWMPWM signals:signals:signals:signals: The PWM signal will be output from Control Card
Max.Max.Max.Max. PWMPWMPWMPWM freq:freq:freq:freq: the max frequency of the PWM signals
EnableEnableEnableEnable Tickle:Tickle:Tickle:Tickle: Let the preionization signals active for some CO2 laser sources.
PulsePulsePulsePulse Width:Width:Width:Width: the pulse width of the preionization signals
PulsePulsePulsePulse Period:Period:Period:Period: the frequency of the preionization signals
UseUseUseUse DigitalDigitalDigitalDigital Q-switchQ-switchQ-switchQ-switch driver:driver:driver:driver: This function is for digital Q-switch. If check this function, the

output port 1 and 2 cannot apply in other purpose. This mode mainly design for Digital Q driver of
Guilin Xingchen

Q-switchQ-switchQ-switchQ-switch OpenOpenOpenOpen whenwhenwhenwhen F.P.KF.P.KF.P.KF.P.K End:End:End:End: If Checked, the Q-switch modulation signal will begin
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pulsing after the FPS delay has expired. Otherwise Q-switch pulsing begins at the end of the Start
TC delay and coincidentally with the beginning of the FPK signal.

FirstFirstFirstFirst PulsePulsePulsePulse KillerKillerKillerKiller (((( F.P.K):F.P.K):F.P.K):F.P.K): the lasting time for the first pulse suppression
PulsePulsePulsePulse widthwidthwidthwidth reverse:reverse:reverse:reverse: Reverse the PWM signal. See figure 10-25

Figure 10-25 pulse width reverse

EnableEnableEnableEnable PowerPowerPowerPower AnalogAnalogAnalogAnalog Output:Output:Output:Output: Enable the control card to output analog signal which used
to control laser power.

PowerPowerPowerPower Mapping:Mapping:Mapping:Mapping: This is power emendation function, used to set the power percentages of
the customized and the corresponding one, as Figure 10-26 shows. If the customized power
percentage is not in the displays of the Power dialog box, the system will pick the linearity margin
values.

EnableEnableEnableEnable FrequencyFrequencyFrequencyFrequency AnalogAnalogAnalogAnalog Output:Output:Output:Output: Enable the control card to output analog signal which
used to control Q-Switch frequency

FrequencyFrequencyFrequencyFrequency Mapping:Mapping:Mapping:Mapping: This is frequency emendation function, used to set the frequency
percentages of the customized and the corresponding one, as Figure 10-27 shows.

EnableEnableEnableEnable CO2CO2CO2CO2 FPKFPKFPKFPK:::: can wipe off the burn-in effect at the start.
EnableEnableEnableEnable CO2CO2CO2CO2 PulsePulsePulsePulse Mode:Mode:Mode:Mode: When selected, the point dist will appear in the parameter, and the

software will be calculated the scan speed according to the setting. The marking points will meet
the setting with this speed.
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Figure 10-26 Power Map Dialog Box Figure 10-27 Frequency Map Dialog Box

EnableEnableEnableEnable AnalogAnalogAnalogAnalog FirstFirstFirstFirst PulsePulsePulsePulse Killer:Killer:Killer:Killer:
Max:Max:Max:Max: Max voltage of analog FPK.
Min:Min:Min:Min: Min voltage of analog FPK.
T1:T1:T1:T1: Time that the FPK signal changes from Max voltage to Min voltage, or reverse.
T2:T2:T2:T2: If the time gap between the laser off and laser on is less than T2, the FPK would not

output.

：The direction that the FPK changes.

About the T1 and T2 we can see figure 10-28：

Figure 10-28
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After selecting fiber, the type of fiber laser will appear in the right, for example, ipg, ipgm,
quantel, raycus, and the corresponding frequency range and MO delay will appear

Test laser
It is used to test whether laser is working normally or not. Hit “test laser” button presenting
dialog box shown in graph 10-29:

Figure 10-29 Test laser dialog box

Fill in the frequency, power, pulse width and laser on time and hit “Laser on”. After that
LASER open and it will close when reach the appointed time.

10.4.310.4.310.4.310.4.3 PortPortPortPort parameterparameterparameterparameter
Equipment port parameter is shown in graph 10-30:
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Figure10-30 Port Parameter Dialog Box

StopStopStopStop MarkingMarkingMarkingMarking InputInputInputInput Port:Port:Port:Port: When in marking process, if the system detects there is a
corresponding input signal, the current marking operation will be ended, and prompt the users
with error information.
OutOutOutOut portportportport forforforfor LaserLaserLaserLaser power:power:power:power: The port can be used to control the laser power supply. If you set
this port, there is a ‘Power off’ button displayed on the marking bar, see the figure

RedRedRedRed lightlightlightlight pointerpointerpointerpointer I/O:I/O:I/O:I/O: The system will output High-level to the appointed output port when
guide light show.
MarkingMarkingMarkingMarking IO:IO:IO:IO: The appointed port will output high level voltage (TTL Compatible) while in
marking.
StartStartStartStart MarkMarkMarkMark IO:IO:IO:IO: In idle state, the software will start mark if detect the high level voltage from
the appointed port
PulsePulsePulsePulse Mode:Mode:Mode:Mode: Checking this option means the soft receive the start signal as pulse mode,
otherwise it is as level mode.
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10.4.410.4.410.4.410.4.4 OtherOtherOtherOther

Figure 10-31 Other Parameter Dialog Box

StartingStartingStartingStarting MarkMarkMarkMark Delay:Delay:Delay:Delay: The delay before marking.
FinishFinishFinishFinish MarkMarkMarkMark Delay:Delay:Delay:Delay: The delay after marking
Max.Max.Max.Max. PowerPowerPowerPower Delay:Delay:Delay:Delay: The Max dealy when the laser power is changed from 0% to 100%

during marking. When the power’s range is changed less then 100% during marking, the time is
less proportional to the Max vaule. This function is suit for the laser power supply with slow
response speed. If the laser power supply’s response speed is very quick, this value may be 0 ms.

Max.Max.Max.Max. FreqFreqFreqFreq Delay:Delay:Delay:Delay: Same as max power delay
ShowShowShowShow startstartstartstart markmarkmarkmark dialog:dialog:dialog:dialog: Every time inquired whether mark it before the marking
EnableEnableEnableEnable executeexecuteexecuteexecute markmarkmarkmark startstartstartstart andandandand stopstopstopstop commandcommandcommandcommand filefilefilefile:::: When the mark started and finishes

needs to execute a command file first.
After enabling this function, when the marking starts, the system will seek for the start.bat

document under the current software of contents automatically and executes it; After the marking
had ended the system will seek for the stop.bat document under the current software of contents
automatically and executes it.

The bat document format is simple, it can use the textual edit software (for example: The
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notepad, tablet and so on the other software) to direct compilation. Bat is the pure ASCII code text
document, altogether has 3 orders.

1. The examination input port orders IN, for example IN2=1 expression system
examination input port 2, if IN2 is the high level downward carries out, otherwise has waited
for that IN2 turns high.
2. The establishment output port orders OUT, for example OUT4=1, the expression system
establishment output port 4 is the high levels.
3. The time delay orders DELAY, for example DELAY=1000, expression system time
delay 1000 milliseconds.
AutoAutoAutoAuto resetresetresetreset markmarkmarkmark countcountcountcount:::: after the mark stop, the software reset mark count automatic
DisableDisableDisableDisable markmarkmarkmark whenwhenwhenwhen reachreachreachreach totaltotaltotaltotal countcountcountcount:::: set the total count, when the amount reached, the

software will not continue mark.
UserUserUserUser stepstepstepstep markmarkmarkmark modemodemodemode:::: When the marking according to the establishment the Galvo smallest

distance movement, delay fixed time after each movement distance, this function mainly uses in
the strong laser power hitting the depth, the step delay is bigger, the laser marks in the pause
position deeply.

EnableEnableEnableEnable analoganaloganaloganalog currentcurrentcurrentcurrent fpk:fpk:fpk:fpk: the time when the analog current is 0 before marking.

FlyFlyFlyFly MarkMarkMarkMark
Mark with working line simultaneously. Hit “fly mark” button presenting the dialog box shown in
graph 10-32.

Figure 10-32 Fly mark set dialog box
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FlyFlyFlyFly mark:mark:mark:mark: choosing this item refers to enable “Fly mark” function.
FlyFlyFlyFly fromfromfromfrom rightrightrightright totototo left:left:left:left: Choosing this item indicates that stream line direction is from right to
left.
FlyFlyFlyFly continuecontinuecontinuecontinue mode:mode:mode:mode: Choosing it indicates mark object is continuous one, namely, we need to
mark content on continuous object. (Such as: wire ,cable and so on).
EnableEnableEnableEnable totaltotaltotaltotal partpartpartpart num:num:num:num: Selecting it indicates the mark “total number” set is effective.
DisableDisableDisableDisable startstartstartstart markmarkmarkmark IOIOIOIO inininin continuecontinuecontinuecontinue mode:mode:mode:mode: it indicates that software doesn’t test start mark
port when marking continuous object. Otherwise, software will test input signal while marking
every time.
EnableEnableEnableEnable hardwarehardwarehardwarehardware flyflyflyfly mode:mode:mode:mode: It indicates that using rotation coder follow linear speed
automatically.
EnableEnableEnableEnable simulationsimulationsimulationsimulation e:e:e:e: It indicates that using simulation hardware method produce linear speed.
It requires appointing speed.
EnableEnableEnableEnable markmarkmarkmark entityentityentityentity bybybyby orderorderorderorder:::: Selecting it indicates that software will mark content
according to its order in the list in turns. Otherwise, software will mark content according to
its position in working space from left to right.
KeepKeepKeepKeep EntitiesEntitiesEntitiesEntities Order:Order:Order:Order: Selecting it indicates that software will mark content according to its
order in the list in turns. The all contents keep opposite locations as drawing.
ReverseReverseReverseReverse EncoderEncoderEncoderEncoder Signals:Signals:Signals:Signals: the signals from encoder is reversed.
FlyFlyFlyFly encoderencoderencoderencoder Offser:Offser:Offser:Offser: the position of marking is in front of actual.
Inport:Inport:Inport:Inport: choose port of flying signal for Board Version 2.2.6 or update.
FlyFlyFlyFly speedspeedspeedspeed coefficient:coefficient:coefficient:coefficient: The calculation formula is shown as follows:

Fly speed coefficient = perimeter of coder tachometer wheel / coder pulse per revolution;

RedRedRedRed LightLightLightLight PointerPointerPointerPointer::::

EnableEnableEnableEnable showshowshowshow contour:contour:contour:contour: When selected, the red light show the object frame, not the rectangle
been made from the max coordinate and the min coordinate of the object.
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RedRedRedRed LightLightLightLight Pointer:Pointer:Pointer:Pointer: Refers to guide light
LightLightLightLight Speed:Speed:Speed:Speed: the speed of guide light
OffsetOffsetOffsetOffset PosPosPosPos XXXX andandandand YYYY:::: it is used to compensate the position error between guide light and the

laser beam.
EnableEnableEnableEnable continuecontinuecontinuecontinue markmarkmarkmark mode:mode:mode:mode: enable this function, return the software surface, click

“Param” then the dialog box popup shown as following Figure，it will be appear after mark stop
every time, the Red Laser Pointing always exist.

10.4.510.4.510.4.510.4.5 HardInfoHardInfoHardInfoHardInfo

There are Board Type, Board Version, SN in the HardInfo.
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